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QUICK START GUIDE  Basic steps for using the tool

TOOL OVERVIEW Introduction to the tool’s conceptual and structural framework 

GETTING STARTED Checklist to prepare for best use of the tool 

THE TOOL: STEP-BY-STEP Detailed instructions on how to use the tool 

GUIDE OVERVIEW

This guide is organized into four sections. It begins with a Quick Start Guide that lists basic, key steps for using the tool. We recommend 
beginning with the Quick Start Guide, and then if you have questions, consulting the remainder of this document. The next section, Tool 
Overview, provides an overview of the tool, including its underlying conceptual and structural framework. The Tool Overview section 
establishes a solid foundation for understanding the individual sections of the tool. The following two sections—Getting Started and 
Using the Tool: A Step-by-Step Guide—discuss detailed steps for preparing for and using the tool.
  

Welcome to Cascadia Consulting Group’s Climate Impacts 
Decision-Support Tool (also known as CIMPACT-DST)! 

This tool guide will help you understand and use the tool so that you 
can use it to its full potential.
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By the end of this guide, you should have the 
knowledge and capacity to:

 Discern situations in which CIMPACT-DST should be used.
 Identify and gather needed information.
 Navigate and complete the tool’s required inputs.
 Understand and use the tool’s outputs.

To make this guide as useful as possible, we 
suggest that you consider the following tips:

 Go in order. 
 Because the tool is organized into sequential stages or “tabs,”   
 we recommend that you follow this guide in order, from   
	 start	to	finish.	Skipping	to	different	sections	could	be		 	 	
 confusing. 
 
 Follow alongside. 
	 This	guide	references	specific	items	in	the	tool	quite	often.		 	
 Follow along with the tool open on your computer,    
 rather than relying solely on the screen shots included in this   
 document.
 
 Look for hints embedded in the tool. 
 There are many hints and tips embedded inside the tool itself.   
 If anything seems confusing, try experimenting with the tool  
	 to	see	if	it	helps.	Click	on	the	“Help”	buttons	(									)	to	find		 	
 useful information within the tool.

We have provided a number of easy-reference icons and sections to 
help you identify useful information throughout this guide:
 

CAUTION! Indicates important information  
 related to the tool’s functionality  
 or usefulness.

TIP! Indicates tips, hints, and tricks  
 for using and understanding the  
 tool.

CHECKLIST Indicates items that will be   
 needed for the tool’s inputs. 

EXAMPLE Indicates an example scenario.
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 QUICK START GUIDE

Below are basic instructions for using the tool. For more information, consult the following sections of this document.
 
 
 

1

Step 1: Select Planning and Project Type.

On the “Project Type” tab, select the 
planning, sector, and project type that 
best apply to your project.

Step 2:  Enter Basic Information.

On the “Project Type” tab, enter the name, 
address, and department of your project. 
These are for informational purposes only.

Step 3:  Select Lifespan/Planning 
Horizon.

On the “Project Info” tab, select the design 
life of your project. If in doubt, choose the 
later year.

Step 5: Consider Outputs. 

On the “Temperature,” “Sea Level Rise” and 
“Precip	&	Streamflow”	tabs,	examine	how	
your project will be impacted by climate 
change and what can be done about it.

Step 4:Determine Hazard Exposure.

On the “Project Info” tab, identify the hazard 
zones that best apply to your project’s 
location. If your project straddles zones, 
choose the zone that represents the highest 
hazard or vulnerability.
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Considera/on of 

climate impacts: 
Are you aware of the risks 

that climate change imposes 

on your project? 

Climate‐proofing: 
How will you adjust your 

project to mi:gate its risk to 

climate change impacts? 

Considera/on of 

climate ac/ons: 
Are you and your team aware 

of ac:ons you can take to 

mi:gate climate change risks 

to your project? 

2 TOOL OVERVIEW

This section provides an overview of the tool’s conceptual and 
structural framework to help you navigate and understand the 
sections of the tool.

What is CIMPACT-DST?

CIMPACT-DST is an Excel-based tool that helps local governments 
and planning agencies incorporate climate change impacts into 
their jurisdiction’s planning and operations. 

Once customized for the jurisdiction, local government staff and 
planners use the tool to identify and consider climate change 
impacts and adaptation options in their decision-making. Climate 
scientists call this process “mainstreaming.”

By using CIMPACT-DST, government staff members across sectors 
and departments can see policies, plans, regulations, and projects 
through	a	“climate	lens”	(see	figure	below).		Consistent	application	
of this lens across city departments will slowly build systemwide 
resilience to climate change within the jurisdiction. 
 

Figure 1. Users of CIMPACT-DST will begin to view policies, plans, regulations, and projects through a “climate lens”. Adapted from the 
OECD Policy Guidance on Integrating Climate Change Adaptation into Development Cooperation (Organization for Economic Cooperation 
and Development (OECD). (2009). Integrating Climate Change Adaptation into Development Cooperation: Policy Guidance. Retrieved from 
www.oecd.org/env/cc/adaptation/guidance)
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CLIMATE INFORMATION: 
CURRENT AND FUTURE
(As available, at relevant scales)

REGULATIONS AND 
POLICIES
(Local, State/Provincial, National)

GOOD ADAPTATION 
PRACTICES
(Regional, international)

LOCATION (SPATIAL) INFORMATION 
OF NATURAL/CLIMATE HAZARDS
(Leveraging existing maps and GIS)

How is CIMPACT-DST Different?

The tool works by compiling multiple sources of locally-relevant 
information—including	reports,	policies,	and	maps—and	filtering	
it based on simple user inputs. This way, the user sees only 
information that is relevant and useful for the task at hand. 
Contrast this to the alternative: wading through a 100-page 
guidance or policy document in search of pertinent information. 
CIMPACT-DST is quick, simple, and practical.
  
 CAUTION!  Please note that CIMPACT-DST is an    
 informational—not analytical—tool. It does not conduct  
	 cost-benefit	or	feasibility	analysis	or	compare	alternatives.			
 For such analyses, there are a variety of other tools    
 available, such   as the CATLoG tool from  the National 
 Climate Change Adaptation Research Facility.  

Conceptual Design

CIMPACT-DST	synthesizes,	simplifies,	and	integrates	different	
types and sources of climate-related information. Embedded 
information that is already built into the tool, listed in Figure 2 
below, includes the following:

 Projected primary climate impacts from the latest climate   
 modeling and science.
 
 Local spatial analyses of projected climate hazards, 
 exposures, and risks.
 
	 Reports	on	projected	sector-specific	secondary	impacts	and		 	
 good practices for building resilience to those impacts.
 
 Integrated guidance from local, state/provincial, and national   
 stakeholders, regulations, and policies. 

Figure 2. Pre-wired information sources for CIMPACT-DST
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The	tool	integrates	the	built-in	information	listed	above	with	user-specified	project	inputs	to	provide	sector-specific	impact	summaries	
and guidance. Sectors included in the tool vary depending on user needs. Cascadia works with each jurisdiction to arrive at a sector list 
and organization scheme that works best for that locale. As an example, the sectors included in a version of CIMPACT-DST customized 
for the city of Hue, Vietnam are listed below:

Figure 3. Project sectors included in the Hue CIMPACT-DST

Master Planning

Urban Transportation 
Planning

Leveling & Surface Water
Drainage Planning 

Disaster Management
& Response

Land Use Planning

Spatial Planning

Spatial Planning

Detailed Planning 
& Zoning

Engineering

Other

Land Use Planning

Infrastructure Planning

Parks & Green Space

Civil Works

Bridges & Roads 

Flood Prevention

Tourism & Services
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Information	on	climate	projections,	hazards,	and	sector-specific	impacts	and	guidelines	are	embedded	in	the	tool.	When	users	add	
information on their project’s sector, lifespan, and location, the tool produces output information. Output information includes bullet-
point	summaries	of	primary	climate	impact	projections,	secondary	sector-specific	impacts,	and	sector-specific	guidelines	and	
recommendations. You can think of these outputs as summaries of the problem (how climate change will affect your project) and the 
solution	(what	you	can	do	about	it).	The	figure	below	illustrates	how	user	inputs	and	information	programmed	into	the	tool	result	in	user-
specific	tool	outputs.

Figure 4. CIMPACT-DST information processing and outputs (circled items 
in blue indicate user inputs)
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Tool Updates

The information embedded in the tool is not permanent. The 
tool can be easily updated as new climate information, policies, 
and analyses are available. It is the responsibility of a local 
Tool Manager to periodically update the tool with this new 
information. If you have questions about the tool’s content or 
would like to submit additions or revisions, please contact your 
local Tool Manager.

Tool Format and Layout

Software and Restrictions

CIMPACT-DST is hosted in Microsoft Excel. The tool has 
macros—pieces of programming that help automate the 
tool— that render the tool only compatible with Microsoft Excel 
versions 2007 or higher. To use the tool, you must enable macros 
(see note below).
 
 CAUTION!  You must have Excel 2007 or a more recent  
 version to use CIMPACT-DST. To determine your version  
 of Excel, go to the “Help” menu and then click on “About  
 Microsoft Excel.” If you do not see this option in the menu,  
 you are probably using Excel 2007 or higher. 

 CAUTION!  You must enable macros to use CIMPACT-DST.  
 When you open the tool in Excel, you may see a yellow  
 ribbon across the top that looks like the following:

To use the tool, you must select “Enable Content.” This will 
enable you to use all of the features of the tool.

Tool Roadmap

The tool is organized into input and output tabs. Each output 
tab is organized by the type of climate impact (temperature, 
precipitation, and sea level rise). The user consults spatial 
tabs to identify project hazard zones. The hazard zones of a 
project inform the content and language of the output tabs. 
Two reference tabs provide further information on the tool’s 
information sources.

Figure 5. The sections, or tabs, of CIMPACT-DST

Project Type 

Project Info 

Temperature 

Precip/Flooding 

Sea Level Rise 

INPUT  

TABS 
Where the user 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informa/on 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the 

type of project, its 

design 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loca/on. 

OUTPUT  

TABS 
Where the tool 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summaries of 

climate impacts and 

guidance. 

SPATIAL  

TABS 
Where the user iden/fies 

project hazard zones. 

Urban Heat 

Island Map 

Flood Map 

Drainage Map 

Vulnerable 

PopulaGon Map 

REFERENCE  

TABS 
Details on the tool’s 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sources. 

Climate Data 

References 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How It Works

There are a variety of protected and hidden elements in 
CIMPACT-DST that the user cannot see or edit. Hidden tabs hold 
embedded information and dropdown lists, hidden programming 
codes help automate the tool, and protected text help avoid 
accidental editing.  These elements are protected and hidden to 
make the tool more simple and easy to use. 
 
 CAUTION! Do not attempt to view or change hidden or    
 protected elements of the tool. Doing so may irreversibly   
 compromise tool functionality.

Saving the Tool

The tool’s inputs and outputs will likely be different each time you 
use it for a different project. You may encounter a scenario in which 
you	would	like	to	save	these	specific	inputs	and	outputs.	To	do	so,	
the	tool	functions	like	any	other	Excel	file.	If	you	save	the	file	as	a	
specific	name,	such	as	“CIMPACT-DST	Bridge	Project	A.xlsm,”	you	
will	see	those	same	inputs	and	outputs	next	time	you	open	the	file.	
We	recommend	that	you	save	the	tool	as	a	separate	file	every	time	
it contains information that you would like to remember or share 
with colleagues. When saving, be sure to save as an “Excel Macro-
Enabled Workbook” (.xlsm, see note below).
 

 

CAUTION! Always save the tool as an “Excel Macro-   
Enabled Workbook (.xlsm).” Failure to do so will compromise  
tool functionality. The picture below shows how to select   
this option from the  dropdown menu when using the “Save  
As” command in Excel.
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 GETTING STARTED

This section details steps that should be considered before 
using the tool.
 
 

 

Step 1: Determine what you need

Because the tool supplies information for only a limited number 
of	sectors,	it	is	first	important	to	identify	whether	the	tool	
contains the information you need. For example, the tool supplies 
information on urban-focused sectors such as urban land use 
planning, transportation planning, water supply, and parks and 
open spaces, but this version does not supply information for 
rural-focused sectors such as agriculture or aquaculture. 
   
 EXAMPLE SCENARIO. John checks the list of sectors  
	 included	in	the	tool	and	identifies	that	his	Town	Center		
	 project	fits	under	the	“Infrastructure	Planning”	sector	of		
 the tool. Step 1 is complete!

Step 2: Be prepared
  
To use the tool successfully, you will need to gather the following 
information about your project:

 • Project name
 • Project location
 • Project sector
 • Project lifespan (design life)
 
 EXAMPLE SCENARIO. John’s project is named “Town  
 Center;” it is located on 112 Main Street; and it has a  
 design life of 50 years. 

Step 3: Plan for use

The tool’s outputs are only as valuable as their application to 
real-world decisionmaking. Before using the tool, develop a clear 
plan for what you will do with the tool’s outputs once you obtain 
them. This includes addressing how you will you store, organize, 
and share the information.

 EXAMPLE SCENARIO. John will share the outputs of  
 the tool with his design team and consider them in project  
 brainstorming meetings.
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Throughout the remainder of the guide, we will 
provide an example scenario to help you understand 
the tool’s practical application. In the example 
scenario, John is a city planner at the City’s Urban 
Planning Institute who is hoping to update a popular 
tourist city building, called Town Center, to give it 
a more modern look. He is using CIMPACT-DST 
to explore ways in which he can build his city’s 
resilience to climate change through more informed 
design and development of the project.

The Example Scenario



11

 USING THE TOOL: A STEP-BY-STEP GUIDE

This section introduces the steps to using the tool, tab by tab. Each step has the following components:
 
 • Roadmap: a screenshot of the tool tab
 • Overview/purpose:	information	the	tab	uses	or	provides	and	how	it	fits	into	the	overall	process
 • Checklist: information the user will need to complete the tab
 • Step-by-step guidance: steps that detail the user options, how to decide which to choose, and the implications for tool outputs

The Basics: Tool Navigation and Guidance

The tool progresses tab-by-tab in the following order:

Navigation buttons, such as depicted below, are provided throughout the tool to guide users through the tabs.

 
 

Note that you can also click on the tabs at the bottom of the Excel sheet to navigate between tabs:

4

Project Type TemperatureProject Info Climate DataSea Level Rise

Back Con(nue 

References
Precip & 
Streamflow
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Click on the arrows next to the tabs to view tabs that are not displayed on your screen:

 TIP! Help icons, indicated by question marks (       ), are located throughout the tool to provide guidance. Simply click on the    
 question marks to reveal or hide helpful information:
 

The	lower	left	of	every	tab	has	a	series	of	modification	buttons	that	provide	a	quick	way	to	modify	views	and	user	inputs.
 

 CAUTION! The Clear Inputs buttons are irreversible. The buttons “Clear All Project Inputs” and “Clear Selections on This Tab” will  
 permanently remove user-entered information in the tool. This action cannot be undone. Be careful before clicking these buttons!

The “Excel Ribbon” refers to the belt of options and selection items across the top of the Excel interface (see below). Hiding the Excel 
Ribbon enables users to more easily view the tool.



13

Saving and Printing

You can save the tool by selecting “View Excel Ribbon” and selecting “Save As” from the “File” menu. Be sure to save as an “Excel Macro-
Enabled Workbook (*.xlsm). You can also use this approach to print the tool outputs (Select “Print” from the “File” menu).
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Tab 1: Project Type

The	“Project	Type”	tab	is	the	first	tab	you	will	see	on	CIMPACT-DST.	
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Overview/Purpose

The “Project Type” tab has a series of basic informational 
inputs that describe the project and provide the basis 
for specific temporal and spatial information later in the 
tool. The Project Type tab also introduces the tool, its 
requirements, and the primary climate change impacts 
addressed by the tool.

 CHECKLIST. To complete this tab, you must have the  
 following information ready:
 
 • Project name
 • Project location
 • Project department
 • Project sector

Step-by-Step Guidance

1. Project Name.	This	field	is	for	informational	purposes	
only. Enter whatever name makes sense to you so that you 
and your colleagues can remember and recognize it later. 

 EXAMPLE SCENARIO. John enters “Town Center”    
 as the Project Name.

2. Site Street Address.	This	field	is	for	informational	
purposes only. It is NOT used to determine the project’s 
exposure to climate change impacts. This is determined on 
the following tab, “Project Info.” 
 
 EXAMPLE SCENARIO. John enters “112 Main Street”  
 as the site address.

3. City Department. This	field	is	also	for	informational	
purposes only. Select your department or the department 
most applicable to the project.
 
 EXAMPLE SCENARIO.  John selects “Hue Planning   
 Institute” as the project department.

4. Planning Type. This	is	a	REQUIRED	field	that	indicates	
the scope of planning that the project entails. To complete this 
field,	choose	one	of	four	options:	Master	Planning,	Detailed	
Planning and Zoning, Engineering, or Other.

 EXAMPLE SCENARIO. John selects “Detailed Planning  
 and Zoning” as the planning type.

5. Sector Type. This	is	a	REQUIRED	field	that	indicates	
the sector of the project. This input will inform the kind of 
impact and guidance information you receive on the output 
tabs	of	the	tool.	To	complete	this	field,	choose	among	the	
specified	options.	If	your	sector	is	not	listed,	consult	the	Tool	
Administrator	or	choose	the	best	fit.	

 EXAMPLE SCENARIO. John selects “Infrastructure   
 Planning” as the sector type.

6. Project Type. If the project is an Infrastructure Planning or 
Civil	Works	project,	then	this	is	a	REQUIRED	field	that	indicates	
the type of infrastructure planning or civil works project. 
Otherwise,	this	field	will	not	appear	and	is	not	required	to	
complete	the	steps	of	the	tool.	To	complete	this	field,	choose	
among	the	specified	options.	Again,	if	your	project	is	not	listed,	
consult	the	Tool	Administrator	or	choose	the	best	fit.	

 EXAMPLE SCENARIO. John selects “Building   
 Construction” as the project type.
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Below is what the Project Type tab of the tool looks like with 
John’s inputs.



Tab 2: Project Info

The	“Project	Info”	tab	is	the	second	tab	of	CIMPACT-DST.	This	is	the	second	and	final	tab	in	which	the	user	enters	information	about	the	
project.  
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Overview/Purpose

Because climate impacts will vary across time and landscapes, the 
tool requires spatial and temporal information about the project. 
To complete this tab, the user must specify the project lifespan and 
view maps to determine the extent to which the project is located 
in “hazard zones.” This information allows the tool to provide more 
precise climate impact and guidance information.

 CHECKLIST. To complete this tab, you must have the   
 following information ready:
 
 • Project lifespan
 • Project location

Step-by-Step Guidance

1. Expected Lifespan of Project.	This	field	can	be	interpreted	
as the design life of a project. The project lifespan is important 
because projects with longer lifespans will need to withstand 
more severe climate impacts. If you want the project to survive 
up to 2050, for example, you would have to design the project to 
withstand the projected impacts in 2050—such as a 1°C increase in 
temperature. If that same project was designed to survive only until 
2030, then the project would only need to withstand the projected 
impacts in 2030, which could be something like a 0.5°C increase 
in	temperature.	The	impact	summaries	in	the	tool	reflect	these	
differences.

 

 TIP! What if my project lifespan is not an option?  If the    
 lifespan of your project is not one of the pre-set    
 options, then choose the next highest available lifespan.   
 For example, if your lifespan is 2040, choose 2050. This   
 provides a conservative estimate that will serve to minimize   
 the risk of climate change impacts to your project. 
 
 EXAMPLE SCENARIO. John’s Town Center project will be   
 designed to last up to 2040. Because 2040 is not an   
 option in the tool, John will select to next highest lifespan:   
 “up to 2050.”
 
2. Hazard Zones. The	remaining	fields	are	for	indicating	the	
hazard zone within which your project is located.  There are four 
hazard zone maps in the Hue CIMPACT-DST:  
 
 1. Flood Zone Map
 2. Vulnerable Population Zone Map
 3. Urban Heat Island Map
 4. Drainage Zone Map
 
All of the above hazard zone maps, with the exception of the 
Drainage Zone Map, are associated with a dropdown menu in the 
tool. The maps are located in separate tabs as shown below: 

The zones represent increasing levels of potential exposure 
or	sensitivity	to	specific	climate	change	impacts.	For	example,	
low-lying projects closer to the river are more likely to be exposed 
to	increased	flooding	than	inland	projects.	The	hazard	zone	you	
select informs the severity and urgency of the impact descriptions 
and guidance information. This feature allows users to fully 
understand the risks and potential consequences associated with a 
project’s proposed location.
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To identify which hazard zone your projected is located within, click 
on the example map on the “Project Info” tab. This leads you to a 
separate	map	(e.g.,	the	“Flood	Map”	tab)	where	you	can	find	the	
location of your project and the hazard zone associated with that 
location.

 TIP!  Click through the sample maps to understand how 
 the hazard maps work. The interactive map on the right   
 of the “Project Info” tab can help orient you to this type   
 of spatial climate hazard information. Click through   
 the various “Zone Map” buttons below the sample map   
 to get a feeling for what these zones mean. 

Step-by-step Instructions for Identifying Your 
Project Hazard Zones

These instructions are for identifying your project Flood Zone (the 
dropdown below). The same procedure can also be used for the 
Vulnerable Population and Urban Heat Island Zone.

 1. First, click on the “Flood Zone Map” button on the    
 bottom-right of the screen. This should reveal the
	 example	flood	zone	map	image.	Notice	how	the	zones		 	 	
 are delineated: different colors represent different zones.
 
 2. Click on the example Flood Zone Map image. This will   
 bring you to the “Flood Map” tab.
 
 3.Use the “zoom” buttons on the bottom right of the   
 Excel screen to zoom into your project area.

	 4.	Note	which	flood	zone	your	project	is	located	within.		 	
 Click the “Back” arrow.
 
	 5.	Choose	the	flood	zone	of	your	project	from	the		 	 	
 dropdown menu.
  
 TIP! What if my project overlaps zones? If your project   
 straddles two or more zones, choose the zone with the 
 higher hazard. For example, if your project straddles   
 the “0.2-0.5m Flood Zone” and “0.5-1m Flood Zone,”    
 then choose the “0.5-1m Flood Zone.” This provides 
 a conservative estimate that accounts for the highest   
 potential level of risk to your project.

The Drainage Zone Map

The Drainage Zone Map is the only map that is not associated with 
a dropdown menu. This map is for informational purposes only. It 
shows	you	the	amount	of	time	it	may	take	for	flood	waters	to	drain	
in your project area. If your project is in an area that drains very 
slowly, then this may carry implications for public health, supply 
chain management, and project site accessibility. The tool is meant 
to raise your awareness of this consideration when planning or 
designing your project. A link to access this map is located on 
the	“Precipitation	&	Streamflow”	tab	of	the	tool,	discussed	in	the	
following section of the guide.

 EXAMPLE SCENARIO. John will examine the hazard   
 maps for his jurisdiction and identify the hazard zones   
 within which the Town Center project is located 
 (indicated by red star on the following pages). Note    
 that this red star will not automatically appear in    
 the tool—you must determine and note the location of   
 your project manually. 
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Flood Zone
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Vulnerable Population Zone
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Urban Heat Island Zone
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Drainage Zone
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Outside a Vulnerable Population Zone:
 

Tabs 3, 4, and 5: Temperature, Flooding, and 

Tabs 3,4, and 5: Temperature, Precipitation/Streamflow, and Sea Level Rise

The	“Temperature,”	“Precip	&	Streamflow,”	and	“Sea	Level	Rise”	tabs	are	the	output	tabs	of	the	tool.
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Overview/Purpose

These three tabs are identical in structure and provide quantitative 
and qualitative summaries of climate change impacts and 
guidance for mitigating those impacts. Note that the outputs on 
these	tabs	are	sector-specific	and	dependent	upon	the	project	
lifespan and location parameters entered on the “Project Info” tab. 
There are three key outputs on these tabs: 1) Projected Impacts 
and Exposure, 2) Impact Overview, and 3) Guidance Information.

 CHECKLIST. 
 • No information needed

Step-by-Step Guidance

1. Projected Impacts and Exposure.The Projected Impacts 
and	Exposure	section	provides	quantitative,	non-sector	specific	
climate impact information. This section has two parts: 1) the 
Projected Range of Impact and 2) the Potential Exposure.

•  Projected Range of Impact. The projected range of impact 
summarizes the latest climate models for the time period of 
interest. This information can help you understand the range of 
temperature, precipitation, and sea levels to expect and plan for 
over the lifetime of your project.

 EXAMPLE SCENARIO. John found that the Town Center 
will be exposed to the projected range of impact depicted  
on the right. He will use this to inform his design team 
that all infrastructure materials must have the capacity to 
withstand this new range of temperature.

 

 
 



TA
B

S
 3

,4
, A

N
D

 5
: T

E
M

P
E

R
AT

U
R

E
, P

R
E

C
IP

IT
AT

IO
N

/S
TR

E
A

M
FL

O
W

, A
N

D
 S

E
A

 L
E

VE
L 

R
IS

E

 

26

•  Potential Exposure. Potential exposure summarizes the risk of 
your project to climate change impacts as a result of its location 
within the hazard maps. For projects located within high-risk 
hazard zones, for example, the tool will indicate a HIGH potential 
exposure for the project.

 EXAMPLE SCENARIO. John found that the Town Center   
 has a MODERATE potential exposure to increased 
 temperature stress. He will use this information to ensure   
 that the Town Center features adequate “shaded retreat”   
 areas to relieve visitors during extreme heat events.    
 Because he is located within a low urban heat island zone 
 with moderately vulnerable populations, he likely will not   
 take more costly action to combat higher temperatures,    
 such as installation of expensive new air conditioning systems.
 

2. Impact Overview. The Impact Overview section is where you 
will	find	sector-specific	qualitative	summaries	of	climate	change	
impacts you should expect to occur for your type of project. You 
should consider these impacts when making decisions about your 
project. 
 
 TIP! Think of the Impact Overview (and Guidance    
 Information) as a checklist. The Impact Overview information 
 can sometimes lead to more questions than answers. 
 For example, the impact may indicate that “higher    
 temperatures may change material performance.”    
 This may lead you to ask, “Which materials will change,   
 and how will they change?” The tool does not provide   
  answers to these questions. It can, however, bring    
 this issue to your attention and allow you to consult the   
  material or design experts on your team for more    
 information. In this way, you can think of the Impact
  Overview as an informal checklist of key issues to consider.  
 Review each item and make note as it is considered.   
 Not all impacts will call for changes in project design or 
 decisions, and that is acceptable. As long as you are aware   
 of the issue and have considered it in the development of   
  your project, you have used the tool correctly.

 EXAMPLE SCENARIO. John found that the Town Center    
 may incur the following temperature impacts from climate   
 change. He will use this information to estimate visitation rates   
 for different areas (e.g., shaded vs. exposed) of the Town Center.
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3. Guidance Information.The Guidance Information section 
provides recommendations and suggestions for taking action to 
address and build resilience in your project to climate change 
impacts. The guidance, which includes information related to the 
physical system of your project, people or communities that may 
be affected, and the project’s underlying institutions, proposes 
ways to ensure that your project “stands the test of time.”  Like 
the Impact Overview section, you do not necessarily need to 
take action on all listed recommendations. Instead, think of this 
section as a checklist of actions to consider and evaluate further.

EXAMPLE SCENARIO. John received the guidance 
information from the tool depicted on the right. He will 
consider these recommendations and ask his design 
team to incorporate twice as many trees as usual in the 
design of the Town Center.
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Tab 6: References

The	“References”	tab	is	the	first	of	two	reference	tabs	in	the	tool.
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Overview/Purpose

The “References” tab is intended for informational purposes only. 
It contains full citations and links to all of the information sources 
referenced in the Impacts Overview and Guidance Information 
sections of the tool. 

 CHECKLIST. 
 • No information needed

Step-by-Step Guidance

1. Reference Type. References	are	categorized	into	five	different	
types.	The	first	two	types,	Vietnam National Reports and Local and 
Provincial Studies and Sources, represent local or regional information 
from	either	the	Vietnamese	government	or	Vietnamese	non-profit	
organizations. National and Continental Studies represent national-level 
information relevant to Vietnam. The remaining categories, United States 
Government Guidance and Other City Adaptation Strategies and Plans, 
contribute	information	that	is	not	Vietnam-specific,	but	could	be	relevant	
to Hue.

2. Reference Number. Every Impacts Overview and Guidance 
Information statement in the tool is followed by a number in brackets 
(e.g., [4]). This number represents the information source for that 
statement. References are numbered in their order of relevance and 
importance to Hue. Lower numbers (1 to 2) denote information derived 
from	official	Vietnamese	government	documents.	Numbers	in	the	middle	
of the range (3 to 8) represent information targeted towards the City of 
Hue, Thua Thien Hue province, or Vietnam as a whole. Higher numbers 
(9 to 15) represent information that was not explicitly generated for 
Vietnam, but may be applicable nonetheless.

Underlined numbers contain hyperlinks to the location of that information 
source on the internet. Click on the number to direct your internet browser 
to	an	online	version	of	the	document	(see	figure	below).

3. File. These icons provide an embedded link for resources that are 
not available online. Double-click on the icon to open the document on 
your	computer	(see	figure	below).	

4. Full Citation. This	field	is	the	full	citation	of	the	information	
source. 
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Tab 7: Climate Data

The “Climate Data” tab is the second reference tab of the tool.

Tab 7: Climate Data

The “Climate Data” tab is the second reference tab of the tool.
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Overview/Purpose

Like the “References” tab, the “Climate Data” tab is intended for 
informational purposes only. It elaborates on the climate projection 
data presented in the “Projected Range of Impact” sections of the 
tool. The tab explains the climate projection data that are available for 
Hue,	their	assumptions	and	specifications,	and	projected	ranges	for	
various lifespans and seasons.

 CHECKLIST. 
 • No information needed

Step-by-Step Guidance

1.	Specifications	Table. This table shows the baseline time period 
and scenarios used to model climate projections for the two most 
relevant Vietnamese government climate projection reports, the 2012 
MoNRE Climate Change, Sea Level Rise Scenarios for Vietnam report 
and the 2008 NCAP/MONRE Climate Change Impacts in Huong River 
Basin and Adaptation in its Coastal District Phu Vang (Thua Thien Hue 
Province) report.

2. Projections Table. The Projections Table provides detailed 
climate impact projections for the Hue region. This table provides a 
wider range of projections than provided in the primary output tabs of 
the tool.
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Questions?

If	you	have	questions,	encounter	difficulties	using	the	tool,	or	have	encountered	an	error	in	the	tool’s	functioning,	content,	or	structure,	please	
contact Andrea Martin of Cascadia Consulting Group at:

andream@cascadiaconsulting.com

She will respond to your inquiry as soon as possible.
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